
August 2016 Master Load and Update 
 
 
 

The August 2016 Master Load is the newest master load for the AristoCAT 
software.  It works with the Windows XP, Vista, Windows 7, Windows 8 & 8.1 and 
Windows 10 operating systems (both 32 and 64-bit).   
 
The August 2016 Master Load is different from previous master loads in that the 
updates to the software may not be part of the master load.  The master load is 
designed to be as trouble free as possible and can be installed with minimal 
concern.  The updates to the master load contain new features and 
enhancements and may have the possibility of programming errors.  Once you 
have downloaded and installed the master load, you can download and install 
updates at any time without needing a code from AristoCAT.  Here are some 
options to consider: 

1. Download and install just the master load.  This may be the safest option 
for some customers.  You can install the master load without a code and 
use it for five days before you will need an activation file.  See the 
activation instructions on the web site. 

2.  For the more adventuresome customer, download and install the update 
as they become available.  You will not need a code to install updates but 
you must have installed the master load first.  If you find a problem with 
the update, you can download and reinstall the master load and you will 
not need a new activation file. 

3. If you are nervous about installing updates, you may want to consider 
waiting until the update has been on the web site for a month or so.  If any 
issues in the update are found by other customers they are usually quickly 
corrected and posted to the web site. 

4. Please call (800-727-4786) or e-mail (support@aristocat.com) with any 
questions or problems you may have. 

 
The following is a list of changes incorporated in this update.  The changes are 
listed in reverse chronological order, so that the most recent changes are listed 
first. 
 
 
April 18, 2018 
Print and Multipag – an option has been added to both programs that allow 

you to append one PDF file to the end of another.   To set these options, start 
the Print or Multipag program and when asked for the name of the file to print, 
click the Cancel button.  Now click the Edit menu and then click the Preferences 
menu.  The Help button will describe the options.  These options can be set 
separately for the Print and Multipag programs. 
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One use for this option would allow you to print the first few pages of a PDF file 
full-sized and the remainder of the pages in the condensed format. 

Example: 

1. You use the full-sized print program to print pages 1 through 4 without a 
word index.  You name the PDF file 'smith 041518'. 

2. You now use the condensed print program to make a PDF file and print 
pages 5 through the last page.  You name the PDF file 'smith 041518' 
(same as the full-sized PDF).  You can optionally include a word index. 
 The word index will not contain any of the words from pages 1 through 4. 

 
 
April 14, 2018 
File Management – A change was made to significantly increase the speed of the 
File Management program, especially when viewing Job Files.  Also if you turn 
on the option to see the number of pages and lines for WRK files, this should 
also be faster. 
 
 
March 5, 2018 
File Management – An Archive Wizard has been added to the File Management 
program.  To start the wizard, click on the Archive menu, then click the Archive 
Wizard menu.  For detail information, click the Help button on each wizard dialog 
box.  An overview can be found at 
http://www.aristocat.com/literature/February2018Newsletter.

pdf 

 
 
January 22, 2018 
Edit - With this update, you can while in Edit, single right-click anywhere in the 
transcript to get a menu.  A new menu item has been added, ‘State Bar Assoc.’.  
If you single left-click on this menu item, it will bring up your state bar association 
web site.   
Note:  This menu item is pre-programmed with the Oregon State Bar Association 
web site.  Since most of you are not from Oregon, this will give you an idea of 
how it works.  To program the web site for your state, open any file In Edit, click 
on Preferences, click on the Proofread button and scroll down to the very bottom.  
Click on the Help button to get instructions on how to determine the web site for 
your state. 
 
 
September 11, 2017 
Each of the AristoCAT programs in the August 2016 Update have been code 
signed.  This should lessen the possibility of an anti-virus program quarantining 
the software. 
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September 10, 2017 
An enhancement has been made to the ‘.cp’ dot command.  The ‘.cp’ dot 
command will start a new page and oftentimes it will create blank lines at the end 
of the current page to force the new page.  Now you can optionally have text 
printed on these blank lines.  Example: 
 
.cp 5, “      /  /  /” 
 
See the description of the ‘.cp’ dot command in Appendix C of the User’s Manual 
for detailed information on the use of this dot command. 
 
 
July 12, 2017 

 Real-time program - We added an option ‘Resume By Line’ to the Real-time 

Options window.  If you set this option to a non-zero value, a by line will 

automatically be added when questioning is resumed after an interruption by 

another speaker.  In your information file, under the Line Layout tab, there is a 

‘By Line Option’ that specifies how to format a by line when you write an 

attorney speaker followed immediately by the question bank.  The most 

commonly used by line format is the word ‘BY’ followed by the attorney name 

and a colon with the question starting on the next line.   

Important Note:  This ‘Resume By Line’ is only available in the real-time 
program.  We will update the translation program in the near future after we 
get feedback on how well it is (or isn’t) working.   
 
Be sure to click the Help button for instructions on how to use this feature. 
 

 Multipag – We have added a ‘Font Auto Size’ check box to the Multipag 

Options window.  If you check this box, Multipag will automatically pick the 

largest font that will fit in the two side-by-side pages.   

 File Management – there has been previous updates to the File Management 

program that allows you to search multiple files by English or steno.  An 

enhancement was added to show the number of occurrences found in each 

file.  This number appears on the far right side of the file name under the 

Pg:Ln column.  In addition, several issues with the searches have been fixed. 

 
June 21, 2017 

 Print and Multipag – On the Print and Multipag Options dialog boxes there is 
a button named ‘Fonts’.  Before this update, if you clicked on this button, you 
would get a message indicating where in your information file you can set the 



font style, and if appropriate, the font size.  Now if you click on this button you 
will see what font is set in your information file and you can make changes to 
the font for the current print session only.   Any changes made here will not 
change the font information in your information file. 

 Print and Multipag – in the May 15th, 2017 update, as described below, three 
preferences were added to these programs.  Now one more option has been 
added, ‘Add Suffix to Job Name’.  If you regularly make full-sized and 
condensed PDF files for your clients, you know that you have to change the 
name of one of them, otherwise one will overwrite the other.  Now you can 
check this box and type in a suffix that will automatically be added to the 
name of the PDF file (this is usually the name of the job).  Examples of a 
suffix can be ‘FullSize’, ‘FS’, ‘Condensed’, ‘CD’, etc.  You can have a suffix 
added to Print or Multipag or both (although if both, the suffix has to be 
different).  See the description below on how to access these preferences.  
 

 
June 16, 2017 

 Multipag (Condensed) Program – two new dot commands have been added 
that allows you to change the header at the very top of the page and the 
footer at the very bottom of the page.  These dot commands are only 
recognized by the Multipag program and, of course, are inserted in the 
transcript.  These dot commands are: 
1. .mh – this dot command will change the header at the top of the page.  

The header will automatically be centered so you don’t want to use the 
tilde (~) to center the header like you would use with the .h1 (.he) dot 
commands. 

2. mf – this dot command will change the footer at the bottom of the page.  
The footer will automatically be centered.  

 
A check box (Font Auto Size) has been added.  If you check this box then the 
Multipag program will automatically calculate the biggest font that will fit inside of 
each page.  This feature can be handy if sometimes you print in portrait mode 
(the normal orientation) and other times you print in Landscape mode (where a 
bigger font will work).  If you don’t check this box then you will have to choose the 
font size in your information file. 
 
 
May 15, 2017 

 Print and Multipag Programs – three new options have been added to the 
Print and Multipag programs.  These options are: 
1. You can set an option that defaults to print to a PDF file rather than to a 

printer.  You can still check/uncheck the ‘Export to PDF’ box.  So if you are 
mostly making PDF files, you may want to check this option. 

2. A feature was added that when you make a PDF file it would ask if you 
wanted to view the PDF file.  Now you can set the option so that it doesn’t 
ask this question. 



3. You can set an option so that after printing a file or making a PDF file, it 
will ask if you want to print another file.  This was the default in the 
Multipag program and now you can change this option.  

 
To set these options, start the Print or Multipag program and when asked for 
the name of the file to print, click the Cancel button.  Now click the Edit menu 
and then click the Preferences menu.  The Help button will describe the 
options.  These options can be set separately for the Print and Multipag 
programs. 
 

 
May 10, 2017 

 File Management – You have been able to double-left click on a PDF file to 
open the file in Adobe Reader or double left-click on a WAV file to open it in 
Windows Media Player.  Now if you double left-click on a WRK, TRN or INC 
file you will get a menu that allows you to open that file in Edit or print it with 
Print or Multipag.  If you double left-click on a NOT file you will get a menu 
that allows you to open that file in View Notes or the Translation program.  If, 
under View Files of Type, you have Job Files and you double left-click on a 
job, you will get a list of all of the files associated with that job along with date, 
time and size information. 
 

 
May 5, 2017 

 File Management – An option has been added that allows you to search all of 
your note files and job dictionaries by steno.  Click the Help menu and Help 
button for details on using this search feature. 

 
 
February 22, 2017 

 File Management – An option has been added that allows you to search your 
files for an English word or phrase.  It will search all of your text files such as 
.WRK, .INC, .TXT, etc. and if it finds the word in a file it will highlight that file.  
You can then view or copy the highlighted files.  Click the Help menu and 
Help button for details on using this search feature. 

 
 
February 13, 2017 

 View Notes – An option has been added so that when you exit the View 
Notes program it will update any personal dictionary entries you made to your 
personal dictionary.  To use this option, open any note file in the View Notes 
program, click on the ‘Preferences’ icon on the toolbar and then check the 
box ‘Update Personal Dictionary’. 

 
 
January 30, 2017 



 Edit  
1. Edit has been updated to allow Copy and Paste from newer versions of 

Microsoft Word.  In addition, several other abnormalities have been 
fixed involving colored text when copying and pasting from Word. 

2. You can now import RTF text from Word or other programs.  To import 
RTF text, create a new, empty WRK or INC file in Edit.  Now click on 
the File menu in Edit, click the ‘Import from…’ menu and then click on 
RTF.  Note:  Importing RTF text will replace any text already in the Edit 
file.  You will want to import an RTF file into an empty Edit file. 

3. You have the option to have defines made in Edit spelled checked 
before they are added to your personal or job dictionary or before it is 
globaled.  To implement this option, open any file in Edit, click on Edit 
Preferences on the toolbar, click on the Proofread button and check 
the box titled ‘Spell Check Defines’.  Click the Help button to get more 
details on how this option works. 

 Edit, Real-time, View Notes and Dictionary Management 
1. These programs allow you to look up words on various Internet sites 

(General Lookup, Medical Lookup and Drug Lookup).  A default web 
site (www.nationmaster.com) was initially programmed into these 
lookups.  However nationmaster.com apparently no longer has word 
definitions on its web site (it does has some other interesting 
information).  So a change was made to have Edit automatically 
change the default web site from www.nationmaster.com to 
www.dictionary.com.  To have Edit automatically make this change, 
open any file in Edit, click on Edit Preferences, then click on the 
Proofread button.  If Edit sees any reference to nationmaster.com it will 
change the reference to dictionary.com.  Note:  If you have already 
changed a reference to your favorite web site(s), they will not be 
affected.  Click the Help button for additional examples of web sites 
and how to program them for the look ups.  You will want to do this 
before using the lookup feature in other programs such as Real-time, 
Dictionary Management, etc.  These other programs using the web site 
information you set in Edit to do the lookups. 

2. You can now program one or more of the lookups to go to a particular 
web site, but not look up a specific word.  This may be helpful if you 
use a website that requires a login.  Click on the Help button to see an 
example of this. 

 Audio Sync and Real-time – these two programs have been updated to allow 
you to try different recording formats to see what works best with your 
computer. 

1. AudioSync – This program has been updated to fix a couple of glitches 
and to allow you to try different recording formats without having to set 
up real-time.  To use the AudioSync program, on the AristoCAT Main 
Menu click on the ‘Job Production’ menu (above the top toolbar), click 
the ‘Translation’ menu, then click ‘AudioSync’.  Now click the Edit 
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menu and then ‘Recording Formats’.  Click the Help button for detailed 
instructions. 

2. Real-time – Different recording formats have been added to the real-
time program.  When you get to the Real-time Options window, click on 
the ‘Format’ button to see the various options.  Note:  The real-time 
program will remember what you have used previously so you don’t 
have to do anything if you are currently happy with the sound quality. 
 

 
December 13, 2016 
The Edit and Real-time programs have an option to update your personal 
dictionary with the entries you made while editing or during real-time when you 
save out of Edit or when you end a Real-time session.  To set these options, in 
Edit, click on the Edit Preferences icon on the toolbar and then click the ‘Dct. 
Upd. Options’ button.  In the Real-time program, when you get to the ‘Real-time 
Options’ dialog box, click on the ‘Dict. Upd. Options’.  Click the Help button for a 
description of the options. 
Notes:   

1. When an entry in the batch file is automatically updated to the personal 
dictionary, you can see these entries by clicking on the Preferences icon 
on the toolbar and then checking the box ‘View Update/Deleted Entries’. 

2. No changes have been made to the job dictionary is updated.  Any entries 
made to the job dictionary during real-time are automatically updated to 
the job dictionary when real-time is ended.  Entries made to the job 
dictionary during editing are updated to the job dictionary or not depending 
on a setting in your information file.  In your information file, under the ‘Edit 
Options’ tab.  If you check the box ‘Update Job Dictionary on Edit Save’ 
(recommended), when you save out of Edit, any job dictionary entries 
made will be updated to the job dictionary.  If it is not checked you will 
have to manually update the entries in Dictionary Management. 

 
 
 
December 5, 2016 
The following enhancements are in the update only (Aug16Upd.exe): 

 Qprint – if you make a PDF file, you will asked if you want to view the PDF 
file. 

 Multipag 
1. If you make a PDF file, you will asked if you want to view the PDF file. 
2. A ‘Rough Draft’ option has been added.  If you check the ‘Rough Draft’ 

box, headers, footers and boxes will not print.  This is will save printer 
toner and is useful for those who like to proofread from paper.  This is 
similar to the ‘Rough Draft’ option in the full-sized print program. 

 Dictionary Management – when editing a job dictionary you have the option 
to move one or more entries from the job dictionary to the personal dictionary 
batch file.  Now you have the option to have those entries automatically 



updated to the personal dictionary when you exit the job dictionary edit.  To 
enable this feature click on the ‘Preferences’ icon on the toolbar and then 
check the box ‘Update Entries Moved to Personal Dictionary. 

 Real-time – On the ‘Real-time Options’ dialog box, a ‘Device Manager’ button 
has been added to make it easier to find your COM port assignments.  You 
can also find this ‘Device Manager’ button under the ‘Real-time Output’ 
options. 

 
 
August 2016 
This is the first version of the August 2016 Master Load.  The file to download is 
Aug16MLD.exe.  This master load is basically identical to the last version of the 
July 2014 master load and is a very stable release.  The biggest difference is the 
method of generating the installation code. 
 


